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1. Overview of LibreOffice and Its Integrated Applications 

LibreOffice is a freely available, fully-featured office productivity suite. Its native 

file format is Open Document Format (ODF), an open standard format that is 

being adopted by governments worldwide as a required file format for publishing 

and accepting documents. LibreOffice can also open and save documents in many 

other formats, including those used by several versions of Microsoft Office.  

LibreOffice includes the following components: 

• Writer (word processor): Writer is a feature-rich tool for creating letters, 

books, reports, newsletters, brochures, and other documents. You can insert 

graphics and objects from other components into Writer documents. Writer 

can export files to HTML, XHTML, XML, Adobe Portable Document Format 

(PDF), and several versions of Microsoft Word files.  

•  Calc (spreadsheet): Calc has all of the advanced analysis, charting, and 

decision making features expected from a high-end spreadsheet. It includes 

over 300 functions for financial, statistical, and mathematical operations, 

among others. The Scenario Manager provides “what if” analysis. Calc 

generates 2D and 3D charts, which can be integrated into other LibreOffice 

documents. You can also open and work with Microsoft Excel workbooks and 

save them in Excel format. Calc can also export spreadsheets in several 

formats, including for example Comma Separated Value (CSV), Adobe PDF 

and HTML formats. 

• Impress (presentations): Impress provides all the common multimedia 

presentation tools, such as special effects, animation, and drawing tools. It is 

integrated with the advanced graphics capabilities of LibreOffice Draw and 

Math components. Slideshows can be further enhanced using Font work 

special effects text, as well as sound and video clips. Impress is compatible 

with Microsoft PowerPoint file format and can also save your work in 

numerous graphics formats, including Macromedia Flash (SWF).  

• Draw (vector graphics): Draw is a vector drawing tool that can produce 

everything from simple diagrams or flowcharts to 3D artwork. Its Smart 

Connectors feature allows you to define your own connection points. You can 

use Draw to create drawings for use in any of the LibreOffice components, 

and you can create your own clip art and then add it to the Gallery. Draw can 

import graphics from many common formats and save them in over 20 

formats, including PNG, HTML, PDF, and Flash.  

• Base (database): Base provides tools for day-to-day database work within a 

simple interface. It can create and edit forms, reports, queries, tables, views, 
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and relations, so that managing a relational database is much the same as in 

other popular database applications. Base provides many new features, such 

as the ability to analyze and edit relationships from a diagram view. Base 

incorporates two relational database engines, HSQLDB and PostgreSQL. It 

can also use dBASE, Microsoft Access, MySQL, or Oracle, or any ODBC 

compliant or JDBC compliant database. Base also provides support for a 

subset of ANSI-92 SQL. 

• Math (formula editor): Math is the LibreOffice formula or equation editor. 

You can use it to create complex equations that include symbols or characters 

not available in standard font sets. While it is most commonly used to create 

formulas in other documents, such as Writer and Impress files, Math can also 

work as a standalone tool. You can save formulas in the standard 

Mathematical Markup Language (MathML) format for inclusion in web pages 

and other documents not created by LibreOffice. 

 
Figure 1: LibreOffice 6 Suite – Overview of Integrated Applications 

 

2. History of LibreOffice: 

LibreOffice originated from the open‐source office suite OpenOffice.org, 

which faced uncertainty after Oracle’s acquisition of Sun Microsystems in 

2009. As the community grew concerned that Oracle might abandon the 

project, independent developers and contributors began planning an 

alternative that would ensure continuity, community governance, and 
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freedom from corporate control. This effort led to the creation of The 

Document Foundation, which was announced on 28 September 2010, 

along with the launch of LibreOffice as a new, community-driven fork of 

OpenOffice.org. Following this announcement, the first stable version of 

LibreOffice (version 3.3) was released on 25 January 2011, built from the 

OpenOffice.org source code but enhanced with community-contributed 

features. Over time, LibreOffice has matured into a robust office suite, 

refined through ongoing development and community collaboration.  

3. Advantages of LibreOffice: 

Here are some of the advantages of LibreOffice over other office suites: 

 • No licensing fees: LibreOffice is free for anyone to use and distribute at no 

cost. Many features that are available as extra cost add-ins in other office 

suites (like PDF export) are free with LibreOffice. There are no hidden charges 

now or in the future. 

 • Open source: You can distribute, copy, and modify the software as much as 

you wish, in accordance with the LibreOffice Open Source licenses.  

• Cross-platform: LibreOffice runs on several hardware architectures and 

under multiple operating systems, such as Microsoft Windows, Mac OS X and 

Linux 

• Extensive language support: The LibreOffice user interface, including 

spelling, hyphenation, and thesaurus dictionaries, is available in over 100 

languages and dialects. LibreOffice also provides support for both Complex 

Text Layout (CTL) and Right to Left (RTL) layout languages (such as Urdu, 

Hebrew, and Arabic). 

 • Consistent user interface: All the components have a similar “look and feel,” 

making them easy to use and master. 

 • Integration: The components of LibreOffice are well integrated with one 

another. – All the components share a common spelling checker and other 

tools, which are used consistently across the suite. For example, the drawing 

tools available in Writer are also found in Calc, with similar but enhanced 
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versions in Impress and Draw. – You do not need to know which application 

was used to create a particular file. For example, you can open a Draw file 

from Writer. 

• File compatibility: In addition to its native OpenDocument formats, 

LibreOffice includes support for opening and saving files in many common 

formats including Microsoft Office, HTML, XML, WordPerfect, Lotus 1-2-3, 

and PDF. 

4. Word processing with LibreOffice Writer: 

Writer is the word processor component of LibreOffice, a freely available, 

fully-featured office productivity suite. In addition to the usual features of a 

word processor (text entry, editing, and formatting; spelling checker, 

thesaurus, hyphenation, and autocorrect; find and replace; and others) 

• Parts of the main Writer window: 

❖ Title bar: The Title bar is located at the top of the Writer window. It 

shows the file name of the current document. When the document is 

not yet named, the document name will appear as Untitled X, where 

X is a number. Untitled documents are numbered in the order in 

which they are created.  

❖ Menu bar: The Menu bar is located just below the Title bar in 

Windows and Linux and at the top of the screen. When you select 

one of the menus, a submenu drops down to show further options, 

including:  

- Commands that directly cause an action, such as Close or Save, in 

the File menu. 

 -Commands that open dialogs. These are indicated by three dots 

following a command, such as Find... in the Edit menu. 

-Commands that open further submenus. These are indicated by a 

right-pointing arrow following a command, such as Toolbars and 

Zoom, in the View menu. Moving the cursor onto one of these 

items causes its submenu to open. 



Chapter III                       FOSS 

6 
 

 

Figure 2: Parts of the main Writer window 

❖ Sidebar: The Sidebar is normally open by default on the right side of the 

Writer window. It contains six main decks: Properties, Page, Styles 

Gallery, Navigator, and Style Inspector. Each deck provides quick access 

to commonly used tools for formatting and managing documents. Users can 

customize which decks are visible through the Sidebar Settings. 

❖ Toolbars: LibreOffice has two types of toolbar locations: docked (fixed in 

place) or floating. Docked toolbars can be moved to different locations or 

made to float. The most-used toolbars in a default installation are the 

Standard toolbar and the Formatting toolbar, which provide quick 

access to commonly used commands for text, graphics, and document 

formatting. 

❖ Status bar :The Writer Status bar is located at the bottom of the workspace. 

It provides information about the document and convenient ways to quickly 

change some document features. It can be hidden by deselecting it in the View 
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menu. 

 

Figure 3: Left side of the Writer Status Bar

 

Figure 4: Writer Status bar, right end 

5. Spreadsheets with LibreOffice Calc: 

Calc is the spreadsheet component of LibreOffice, offering additional features 

such as: 

 • Functions, which can be used to create formulas to perform complex 

calculations on data.  

• Database functions to arrange, store, and filter data.  

• Data statistics tools, to perform complex data analysis.  

• Dynamic charts, including a wide range of 2D and 3D charts. 

 • Macros for recording and executing repetitive tasks; scripting languages 

supported include LibreOffice Basic, Python, and JavaScript. 

 • Ability to open, edit, and save Microsoft Excel spreadsheets.  

• Import and export of spreadsheets in multiple formats, including HTML, 

CSV, PDF, and Data Interchange Format 

• Parts of the Calc main window: 
❖ Title bar: The Title bar, located at the top, shows the name of the current 

spreadsheet. When the spreadsheet is newly created, its name is Untitled X, 

where X is a number. When you save a spreadsheet for the first time, you are 

prompted to enter a name of your choice.  
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Figure 5: Calc main window 

❖ Menu bar: Under the Title bar is the Menu bar. When you choose one of the 

menus, a list of options appears. You can also modify the Menu bar, setting 

up and Customizing.  

• File – contains commands that apply to the entire document, such as Open, 

Save, Wizards, Export as PDF, Print, Digital Signatures, Templates.  

• Edit – contains commands for editing the document, such as Undo, Copy, 

Find and Replace, Track Changes.  

• View – contains commands for modifying how the Calc user interface looks, 

such as Toolbars, View Headers, Full Screen, Zoom.  

• Insert – contains commands for inserting elements into a spreadsheet, such 

as Image, Chart, Text Box, Headers and Footers. 

• Format – contains commands for modifying the layout of a spreadsheet, 

such as Cells, Page Style, AutoFormat Styles, Align Text. 

 • Styles – contains options for applying and managing styles, such as 

Heading 1, Footnote, Manage Styles.  

• Sheet – contains commands for inserting and deleting elements and 

modifying the entire sheet, such as Delete Rows, Insert Sheet, Rename 

Sheet, Navigate. 
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 • Data – contains commands for manipulating data in your spreadsheet, such 

as Define Range, Sort, AutoFilter, Consolidate, Statistics.  

• Tools – contains functions to help check and customize a spreadsheet, for 

example Spelling, Share Spreadsheet, Macros, Options. 

 • Window – contains two commands; New Window and Close Window. 

Also shows all open windows in other LibreOffice applications.  

• Help – contains links to LibreOffice Help, User Guides, and other 

miscellaneous functions. 

❖ Toolbars: The default setting when Calc opens is for the Standard and 

Formatting toolbars to be docked at the top of the workspace. Calc toolbars 

can be either docked (fixed in place), or floating, allowing you to move a 

toolbar to a more convenient location on your workspace. Docked toolbars 

can be undocked and moved to a different docked location or become 

floating toolbars. Likewise, floating toolbars can be docked. 

❖ Formula Bar: The Formula Bar is located at the top of the Calc workspace. 

It is permanently docked in this position and cannot be used as a floating 

toolbar.  

❖ Status Bar: The Status Bar at the bottom of the workspace provides 

information about the spreadsheet and convenient ways to quickly change 

some of its features.  

❖ The Sidebar: is a mixture of toolbar and dialog. When opened (View > 

Sidebar), it appears on the right side of the window. When entering or 

editing data in cells, the Sidebar consists of five decks: Properties, Styles, 

Gallery, Navigator, and Functions. Each deck has a corresponding icon on 

the Tab panel to the right of the Sidebar, allowing the user to switch between 

them. 
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6. Presentations with LibreOffice Impress: 

LibreOffice Impress is the presentation software of the LibreOffice suite, 

used to create slideshows, multimedia presentations, and visual reports. 

 

Figure 6: Impress main window  

❖ Menu bar: The Impress Menu bar, at the top of the main window, provides 

several menus common to all LibreOffice modules. The commands may 

differ between the modules for File, Edit, View, Insert, Format, Tools, 

Window, and Help. Impress has two extra menus for Slide and Slide Show. 

When you select one of the menus, a sub-menu drops down to show 

commands. The Menu bar can be customized and for more information, see 

the Getting Started Guide. 

❖ Workspace: The Workspace opens in the Normal view. It has four standard 

views selected using tabs: Normal, Outline, Notes, and Slide Sorter.  

❖ Slides pane: The Slides pane contains thumbnail images of slides in a 

presentation in the order in which they will be shown. Clicking on a slide 

image in the Slides pane selects it and places the slide in the Workspace 

where the user can make changes to the displayed slide.  
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❖ Sidebar: The Impress Sidebar, normally located on the right side of the 

Workspace, is similar to the Sidebar in the other LibreOffice modules and 

consists of seven decks. 

❖ Status bar: The Status bar located at the bottom of the main window, 

contains information that the user may find useful when working on a 

presentation.  

❖ Toolbars: help in creating and formatting slides. The most commonly used 

toolbars are the Standard toolbar and the Drawing toolbar, which are 

shown by default. Other toolbars can be displayed or hidden via View > 

Toolbars. 

7. Introduction to LibreOffice Base: 

Base is the database component of LibreOffice. It is used to store, organize, 

and manage data. Base includes four main work areas: Tables, Queries, 

Forms, and Reports, which allow users to enter data, retrieve information, 

and create structured reports 

 

 

Figure 7: View of Base 
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• Interface of LibreOffice Base: 

The LibreOffice Base interface is designed to be simple and easy to use. When 

Base is opened, the main window displays the database file and provides access 

to all database objects through a clear layout. 

❖ Menu bar, located at the top of the window, contains commands such as 

File, Edit, View, Insert, Tools, Window, and Help. These menus allow 

users to create, open, save, and manage database objects. 

❖ Toolbars, which provide quick access to frequently used commands. 

Toolbars can be shown or hidden depending on the user’s needs. 

❖ Database pane, which lists the main database objects: Tables, Queries, 

Forms, and Reports. Selecting any of these objects allows the user to 

create, edit, or view them. 

❖ Workspace, located in the center of the window, displays the selected 

object and its contents. This area is used to design tables, run queries, fill 

forms, and view reports. 

❖ Status bar provides information about the current database and the 

actions being performed. 

Structure of the Database Pane: 

 

Figure 8:  The Base database objects 
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✓  Table: is the fundamental object in a relational database and tables use 

rows and columns to present the data—rather like a spreadsheet. You will 

learn about Tables and in this lesson, as well as how to use the Design 

View to create a table, add fields to a table, and define the type of data 

that is in a specific field. 

✓ Query: makes a request to the database, asking it to find some specific 

data that are stored in the database.  

✓   Form: gives the user another way of looking at the data in the database. 

Whereas a Table allows the user to view many records at once, a Form 

displays the contents of just one record at a time. Forms are very useful 

for entering data into new records or updating the data in existing records. 

✓  Report :is used to present a selected set of information from a database 

neatly laid out and thus easier for the user to mentally digest 

8. Vector drawing with LibreOffice Draw: 

is a vector graphics program that can also handle some raster images. It allows 

users to create a wide variety of images using geometric elements such as lines, 

circles, and polygons. Vector graphics are easier to store and scale. Draw is 

fully integrated with the LibreOffice suite, making it easy to reuse drawings in 

Writer or Impress. Its functionality is extensive, offering many tools for creating 

and editing graphics. 

Draw main window: 

 

Figure 9: Draw main window 
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❖ Standard Toolbar : The Standard toolbar contains general commands used 

in most LibreOffice applications, such as New, Open, Save, Print, 

Undo, and Redo. It provides quick access to basic file and editing 

operations. 

❖ Drawing Toolbar: The Drawing toolbar is one of the most important 

toolbars in Draw. It contains tools for creating vector objects such as 

lines, rectangles, circles, curves, text boxes, and connectors. This 

toolbar is usually located at the bottom of the workspace. 

❖ Formatting Toolbar: The Formatting toolbar is context-sensitive and 

changes depending on the selected object. It allows users to modify the 

appearance of objects by changing colors, line styles, text alignment, 

font size, transparency, and effects. 

❖ Line and Filling Toolbar: This toolbar is used to control the properties of 

lines and filled objects. It includes options for line width, line style, fill 

color, gradient, and shadow. 

❖  Text Formatting Toolbar: The Text Formatting toolbar appears when 

text is selected. It contains tools for font type, font size, bold, italic, 

alignment, and text color. 

❖ Status Bar: Although not a toolbar in the traditional sense, the Status bar 

provides useful information about the drawing, such as object position, 

size, zoom level, and page style. 
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